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Abstract 
 

Cardiovascular diseases are a major cause of health problems and death in developed 

countries. Atherosclerosis is the most predominant form of vascular disease and 

consists in lipid accumulation in the wall of large- and medium-sized arteries. It is 

associated with systemic risk factors, but disturbed haemodynamics and complex 

vessel geometry play a localizing role in atherosclerotic plaque formation. The 

prevailing theory recognizes low and oscillatory wall shear stress (WSS) acting on the 

endothelial layer as indices of disturbed flow that promote atherosclerosis 

progression. Contradictory findings and an unsatisfying co-localization of 

low/oscillatory WSS with atherosclerotic lesions however encouraged the 

investigation of different WSS features that correlate with disease initiation and 

progression. So, temporal multidirectionality of WSS has recently been proposed as a 

pro-atherogenic factor.  

Aim of this thesis was to introduce new hemodynamic wall parameters (HWPs) able to 

distinguish among tensile, compressive and uniform shear stresses acting on the 

endothelial cells. The direction of WSS could influence the morphology and the biology 

of endothelial cells, increasing the permeability to atherogenic particles under the 

endothelium and altering the balance between pro- and anti-atherosclerotic signals. 

However, none of the existing HWPs can capture the spatial directionality of WSS.  

For this purpose, HWPs based on WSS divergence were proposed: Positive WSS 

Divergence (DivP), Negative WSS Divergence (DivN) and Oscillatory WSS Divergence 

Index (ODI). The divergence of WSS can measure the tendency of WSS vector field to 

converge toward or diverge from a point. More in detail, a positive divergence 

identifies a source-arranged field, that results in an expansion of the vessel wall, 

whereas a negative divergence highlights a WSS field with a sink configuration, that 

causes a compression of the endothelium. So, the proposed divergence-based 

descriptors allow an evaluation of WSS vector field direction throughout the cardiac 

cycle. ODI was defined as an index that quantifies the oscillations of WSS direction 

between the source and sink configurations. 

The divergence of WSS vector field takes into account both the magnitude and the 

direction of WSS. So, to evaluate the WSS directionality only, neglecting the variations 

in WSS magnitude, it was considered the divergence of the normalized WSS. It was 

computed as the sum of the spatial derivatives of the normalized WSS components in 

each triangle of the surface meshes. 

The divergence-based HWPs were computed on the luminal surfaces of forty-six 

models of right carotid bifurcations acquired from healthy people. Then, a co-

localization analysis of the divergence-based descriptors with the established HWPs 

was carried out through a visual examination of the critical surface areas and a 

systematic quantification, by means of similarity indices, of the spatial overlapping of 

surface areas exposed to disturbed flow, as defined by each HWP.  
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Surface areas mainly exposed to negative divergence resulted to be more 

concentrated around the bifurcation expansion. DivN pointed out regions 

characterized by sink-arranged WSS field, it moderately co-localized with HWPs that 

indicate blood stagnation, high near-wall residence time of particles and uniaxial 

oscillatory WSS. Regions predominantly exposed to positive divergence were mainly 

located at the bifurcation apex. DivP pointed out multidirectional source-arranged 

WSS vector field. ODI co-localized with HWPs that identify surface areas exposed to 

uniaxial highly oscillating WSS, flow reversal regions, high residence time regions and 

recirculation zones.  

The potential correlation between the directional changes of WSS that the proposed 

divergence-based HWPs can identify and atherosclerotic lesion appearance needs to 

be checked. 
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Chapter 1. Cardiovascular system 

Cardiovascular system is a closed loop system, composed by two distinct circuits: the 

systemic and the pulmonary circuits. The circulatory system consists of heart, blood 

and a network of blood vessels (arteries, veins and capillaries). It delivers oxygen, 

nutrients and other substances to body tissues and carries waste products derived 

from cellular metabolism to the organs responsible for their elimination.  

The blood is a suspension of cellular components in an aqueous solution. The 

suspending medium is called plasma, the suspended particles include red blood cells, 

white blood cells and platelets. The heart is the pump that propels the blood into the 

vessels. It is a muscular organ, whose contraction generates the pressure that is 

necessary to eject blood into the major vessels, from which blood is distributed to the 

body. The heart contains four chambers, two atria (the upper ones) and two ventricles 

(the lower ones). The left side chambers supply the systemic circulation, whereas the 

right side chambers supply the pulmonary circulation. The atrium and the ventricle of 

each side are separated by a valve, whose opening and closure are regulated by the 

pressure gradient to ensure the unidirectionality of blood flow, and to avoid blood 

regurgitation. 

Systemic arteries provide oxygen-rich blood from the left ventricle of the heart to body 

tissues. The blood returned to the heart through systemic veins has less oxygen, since 

much of the oxygen carried by the blood has been delivered to the cells. So, arteries in 

the pulmonary circuit carry blood low in oxygen to the lungs for gas exchange. Then, 

pulmonary veins return freshly oxygenated blood from the lungs to the heart to be 

pumped into systemic circulation (Figure 1).  

 

 

Figure 1. Circulatory system: Pulmonary and systemic circuits 
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1.1 Blood vessels 
 

Blood circulates through the whole body via blood vessels. The vessels that carry 

blood away from the heart to peripheral organs are called arteries. They branch 

into smaller vessels known as arterioles, that further branch into tiny capillaries, 

where gas, ions, nutrients and wastes are exchanged between blood and body 

tissues. Blood drains from the capillaries into venules, small blood vessels that then 

unite to form veins, larger blood vessels that transport the blood back to the heart 

(Figure 2). 

 

 

Figure 2. Blood vessels: arteries, capillaries and veins 

 

Arteries and veins differ structurally and functionally. Arteries transport blood 

under high pressure, which is exerted by the pumping action of the heart. So, 

arteries possess thick, strong, elastic walls to ensure fast and efficient blood flow 

to body tissues, whereas veins withstand a much lower pressure, so they have 

thinner walls and larger lumens, i.e. the passageways through which the blood 

flows, allowing more blood to flow with less vessel resistance. In addition, many 

veins of the body contain valves that assist the unidirectional flow toward the 

heart, preventing the backflow of blood. 

 

1.2 Structure of blood vessels walls 
 

Both arteries and veins walls consist of three tissue layers (Figure 3), called tunics: 

- Tunica intima: the innermost and thinnest layer composed of epithelial and 

connective tissue layers. The inner surface of the tunica intima is a thin layer 

called endothelium, that isolates the blood circulating into the lumen and his 

components from the underlying thrombogenic tissues. Damage to this 
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endothelial continuous lining and exposure of blood to the collagenous fibers 

beneath is one of the primary causes of clot formation. Next to the 

endothelium is the basal lamina, a subendothelial permeable layer containing 

type IV collagen with a structural function. In larger arteries, an internal elastic 

lamina also exists. It is a layer of longitudinally arranged elastic fibers 

permeated with small openings and it delimits the tunica intima from the 

- Tunica media: a layer of alternated smooth muscle cells and elastic fibers 

arranged in circular sheets. In large and medium sized arteries, this is the 

thickest layer and it contains a large amount of elastin. Smooth muscle cells 

control the calibre of the vessel maintaining blood pressure and proper 

circulation. Contraction of the circular muscles decreases the vessel lumen, 

reducing blood flow and increasing blood pressure, whereas their vasodilation 

increases blood flow as the smooth muscle relaxes, allowing the lumen to 

widen and blood pressure to drop. Therefore, the tunica media is responsible 

for the pulsatility of blood flow. A second layer of fenestrated elastic fibers, 

called the external elastic lamina, separates the tunica media from the 

- Tunica adventitia: the outermost layer, that consists mainly of connective 

tissue fibers that protect and reinforce the vessel. This is normally the thickest 

tunic in veins. In large vessels, it contains vasa vasorum, i.e. capillaries that 

supply nutrients to the vessel wall. 

The layered structure of vessel walls gives rise to anisotropic mechanical 

properties, with different elastic moduli in the axial and circumferential directions. 

 

 

Figure 3. Structure of blood vessels walls 
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1.3 Vascular diseases  

Cardiovascular diseases are a major cause of health problems and death in 

developed countries. In the more technologically developed countries of the 

world, such as the United States, the United Kingdom, and most other European 

countries, the most predominant form of cardiovascular disease is arteriosclerotic 

disease. There are three recognized types of arteriosclerosis: arteriolosclerosis, 

Monckeberg medial calcific sclerosis and atherosclerosis. 

1.3.1 Arterioscleosis 

Arteriolosclerosis affects small arteries and arterioles. It is a chronic disease that 

involves an abnormal thickening and hardening of the vessel walls, with a resulting 

narrowing of the lumen and loss of elasticity.  

1.3.2 Monckeberg medial calcific sclerosis 

Monckeberg medial calcific sclerosis is a disease characterized by deposits of 

calcium in the tunica media of muscular arteries in people over age 50. These 

calcifications do not decrease the size of the arterial lumen. 

1.3.3 Atherosclerosis 

Atherosclerosis is a slow and progressive chronic, inflammatory, fibroproliferative 

vascular disease of large- and medium-sized arteries [Chatzizisis et al. 2007]. It 

consists in lipid accumulation in the artery wall, between the tunica media and the 

tunica intima, so that plaque builds up inside the arterial lumen (Figure 4, Panel B). 

Plaques are made up of fat, cholesterol, calcium and fibrin. Over time, these 

deposits in arteries cause the thickening of the vessels walls, and so their 

weakening and loss of flexibility. This narrows the opening [3], reducing or even 

totally blocking the blood flow and the supply of oxygen to cells and organs. 

Atherosclerosis typically does not produce symptoms until the luminal diameter of 

the vessel has been decreased by 70 to 80 percent. 
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Figure 4. Atherosclerosis: A) Normal artery with a normal blood flow B) Narrowed artery with abnormal blood flow 

 

Consequently, atherosclerosis can lead to serious diseases [3]: 

- coronary heart disease, if the coronary arteries that supply oxygen-rich blood 

to the heart are blocked. In this case a heart attack or an angina can occur; 

- carotid artery disease, when the plaque builds-up in the carotid arteries, that 

provide blood to the brain (Figure 5). So, a stroke can occur, and brain cells 

deprived of oxygen begin to die; 

- peripheral artery disease, if an artery delivering oxygen to the extremities (legs, 

arms and pelvis) is blocked. This can result in gangrene; 

- chronic kidney disease, if the plaque builds-up in the renal arteries causing a 

loss of kidney function. 

 

 

Figure 5. Carotid artery disease 
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Chapter 2. Hemodynamics  
 

Hemodynamics is the physical study of flowing blood and of all the solid structures 

through which it flows. It deals with the distribution of pressures and flows in the 

circulatory system. The heart pressurizes the blood, providing energy that drives it 

through the vascular network. Blood vessels may participate in the distribution of 

blood by active contraction or dilation [Secomb, 2017]. 

 

2.1 Rheologic properties of blood  
 

The blood is subject to mechanical forces resulting from blood flow and blood 

pressure, that may be described using the concept of stress, i.e. the force per unit 

area acting on a surface within or on the boundary of the material. The stress is a 

second order tensor that allows the representation of the traction forces acting on 

the chosen surface. In the Euclidian space, the stress tensor has nine components 

σij, where the subscripts can take the values 1, 2 or 3. Each component represents 

the force in the i-th coordinate direction acting on a surface whose normal vector 

is the j-th coordinate direction. So, stress tensor consists of three normal 

components and six tangential ones. If i=j, the component is defined normal stress, 

because it acts perpendicular to the surface, whereas if i≠j the stress is referred to 

as a shear stress, that acts parallel to the surface.  

Considering a fluid flowing between two parallel plates (Figure 6) placed at a 

distance h, with one plate (at y=0) at rest and the other one (at y=h) moving 

parallel to itself in the x direction with constant velocity vx, according to the no-

slip condition, the fluid adjacent to a surface moves at the same velocity as the 

solid surface does. This leads to the establishment of velocity gradient. Thus, as 

the fluid particles travel parallel to the wall, their velocity increases from zero to a 

maximum value at y=h. The velocity gradient (shear rate) is given by Eq. 1: 

�̇� =  
𝑑𝑣𝑥

𝑑𝑦
  Eq. 1 

  

 

Figure 6. Fluid flowing between two parallel plates 
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Shear rate is defined as the rate at which adjacent layers of fluid move with respect 

to each other [Papaioannou and Stefanadis, 2005]. 

To resist the deformation of fluid resulting from the velocity gradient, a shear stress 

τxy is generated in the fluid, owing to the dissipation of energy caused by the sliding 

of fluid molecules. The resistance of the fluid to deformation is described by a 

constant known as viscosity μ, defined as the ratio of the shear stress to velocity 

gradient. So, the shear stress is: 

 

𝜏𝑦𝑥 = −μ�̇� =  −𝜇
𝑑𝑣𝑥

𝑑𝑦
 Eq. 2 

 

This relation is valid only for Newtonian fluids (Figure 7), whose viscosity is an 

intrinsic property at a given temperature and pressure, independent of shear rate.  

The minus sign is needed because τ is defined in the negative direction. 

On the other hand, the blood shows non-Newtonian properties, it is governed by 

a non-linear relationship between shear stress and shear rate (Figure 7).  

 

 

Figure 7: Shear stress-shear rate relationship for Newtonian fluid and blood 

 

Blood viscosity depends on pressure, temperature and shear rate. At very low 

shear rates, blood viscosity increases (Figure 8). This phenomenon is known as 

shear-thinning and results almost entirely from red blood cells behaviour in 

suspension. In fact, under low-flow conditions, the erythrocytes can adhere to each 

other, leading to the formation of stacks of cells known as rouleaux, that create 

more interference with the flow. So, the aggregation contributes to the non-

Newtonian behaviour of blood. High values of haematocrit i.e. the volume fraction 

of red blood cells, whose value in an adult is usually assumed to be equal to 45%, 

can promote red blood cells adhesion. 
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Figure 8. Dependence of the human blood viscosity on haematocrit, for indicated shear rates 

 

This strong increase in viscosity due to the aggregation of red blood cells can be 

observed comparing normal blood with red blood cells in a Ringer solution, that 

has the same viscosity as plasma, but does not contain fibrinogen, which is 

responsible for the aggregation in rouleaux (Figure 9). Another phenomenon could 

be observed if erythrocytes are hardened. In this case, the viscosity results 

independent of shear rate and higher than the viscosity of normal red blood cells 

in the same medium (Figure 9). This result shows that at high shear rates the 

deformability of red blood cells is responsible for the reduction in blood viscosity. 

In fact, in this flow condition, the erythrocytes assume an ellipsoidal shape with 

the principal axis aligned with the direction of flow, and so they offer less resistance 

to the flow [Secomb, 2017]. 

 

 

Figure 9. Dependence of the viscosity on the shear rate for three different red blood cells suspensions 
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In arteries with normal blood flow rates (in the range of hundreds or thousands), 

blood can be considered as a Newtonian fluid with good approximation [Secomb, 

2017; Sousa et al. 2014], whose viscosity is approximately 3.5 cP (for 45% 

haematocrit) [Papaioannou and Stefanadis, 2005].  

In addition, being a suspension of particles, the blood is not a homogeneous fluid. 

However, in vessels whose diameters are much larger than the suspended 

particles, it can be considered as a continuum [Secomb, 2017]. 

So, the blood can be characterized by both the viscosity and the density. These 

physical quantities are dependent on the temperature. The viscosity could depend 

also on the state of motion of the fluid. The density of the blood can be calculated 

as in Eq. 3: 

 

ρ =  (1 − 𝐻𝑡)𝜌𝑝 + 𝐻𝑡𝜌𝑟𝑐   Eq. 3 

 

where Ht is the haematocrit, ρp is the plasma density (ρp=1035 kg/m3) and ρrc is the 

particles density (ρrc=1090 kg/m3). So, the blood density value is 1060 kg/m3. 

 

2.2 Reynolds number 
 

The relationship between driving pressure and flow in a given vessel can be 

understood by considering the viscous and inertial forces acting on the blood.  

The Reynolds number is defined as the ratio of the inertial term to the viscous term. 

So, if the fluid has density ρ and viscosity μ, and the fluid flow is characterized by a 

typical velocity v and typical length L (for a tube L is the diameter), the Reynolds 

number (Re) is defined as follows: 

 

Re =  
𝜌𝑣2 𝐿⁄

𝜇𝑣 𝐿2⁄
=  

𝜌𝑣𝐿

𝜇
  Eq. 4 

 

This dimensionless parameter allows to predict fluid flow conditions. When 

Re<2000 the inertial term is negligible and the flow is laminar, the fluid motion is 

smooth and orderly, fluid particles move in straight lines. If 4000<Re<10000 the 

flow is transitional, whereas when Re>10000 turbulent flow occurs, the flow is 

unstable and it involves unpredictable fluctuations of velocity.  

The Reynolds numbers of arterial flow are in the range of hundreds to low 

thousands. So, in physiologic conditions, the blood flow is laminar or at most 

transitional, but flow fields can be sensitive to geometrical irregularities due to 

pathologic alterations or presence of vascular protheses in the vessel. 
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2.3 Navier Stokes equations  
 

If v=(vx,vy,vz) is the velocity vector, then the conservation of mass implies that: 

 

𝐷𝜌

𝐷𝑡
+ ρ (

𝜕𝑣𝑥

𝜕𝑥
+

𝜕𝑣𝑦

𝜕𝑦
+

𝜕𝑣𝑧

𝜕𝑧
) = 0  Eq. 5 

 

where the material derivative 
𝐷𝜌

𝐷𝑡
=

𝜕𝜌

𝜕𝑡
+ 𝒗∇𝜌 has been introduced. 

On the other hand, the conservation of momentum leads to: 

 

ρ
𝐷𝒗

𝐷𝑡
= −∇𝑝 − ∇ ∙ 𝜏 + 𝜌𝒈  Eq. 6 

 

where 
𝐷𝒗

𝐷𝑡
 is the material derivative of v, ∇p is the pressure gradient, g is the gravity 

force. 

Continuity equation (Eq. 5) and momentum conservation equation (Eq. 6) are 

referred to as the Navier-Stokes equations. 

Blood can be regarded as an incompressible fluid, so his density ρ=ρ(t,x,y,z) is 

constant. Therefore, 
𝐷𝜌

𝐷𝑡
= 0 and continuity equation becomes: 

 

∇𝒗 = 𝟎  Eq. 7 

 

where ∇𝒗 is the velocity gradient. 

In the case of incompressible Newtonian fluid, both ρ and μ are constant, so 

momentum equation is the following: 

 

ρ
𝐷𝒗

𝐷𝑡
= −∇𝜌 + 𝜇∇2𝒗 + ρ𝒈  Eq. 8 

 

where ∇2𝒗 = ∇(∇ ∙ 𝒗) is the Laplacian of v.  

Solving the Navier-Stokes equations, for a given geometry and a set of boundary 

conditions, predicts the fluid velocity and its pressure. Because of their complexity, 

these equations can be analytically solved only in a few simple cases. For complex 

geometries, Navier-Stokes equations have to be numerically solved.  

 

2.4 Poiseuille’s law 
 

Assuming that blood is an ideal Newtonian fluid with constant viscosity, the vessel 

is straight, cylindrical and inelastic, the blood flow is steady (constant in time) and 

laminar and the flow is not subject to entrance effects (non-uniformities associated 

with the entrance of fluid into the vessel), then the velocity profile in the duct is 

parabolic (Figure 10) and it can be described by the Eq. 9. 



18 
 

v(r) =  −
∆𝑃(𝑅2−𝑟2)

4𝜇𝐿
  Eq. 9 

 

Where L is the length and R is the radius of the vessel, ΔP is the pressure drop over 

the tube that supplies the driving force to the fluid, whose viscosity is μ, to flow. 

The maximum velocity occurs at the centre of the pipe (r=0), whereas at the wall 

(r=R) the velocity is null. Integrating the velocity across the circular cross-section of 

the tube, it is possible to calculate the volume flow rate Q in the vessel as: 

 

Q =  ∫ 2𝜋𝑟𝑣(𝑟)𝑑𝑟 =  
𝜋𝑅4∆𝑃

8𝜇𝐿

𝑅

0
  Eq. 10 

This equation is known as the Poiseuille’s law. The mean velocity of flow in the 

tube is then given by Eq. 11: 

𝑣𝑚𝑒𝑎𝑛 =  
𝑄

𝜋𝑅2
=

𝑅4∆𝑃

8𝜇𝐿
  Eq. 11 

 

The mean velocity of flow equals one half of the peak velocity at the center-line. 

  

 

Figure 10. Poiseuille flow: parabolic velocity profile 

 

One of the assumptions behind Poiseuille’s law is that there are no entrance 

effects. When a fluid enters a tube, for the flow to be fully developed and the 

velocity profile to be parabolic, the fluid must travel a distance known as entrance 

length. The boundary layer is the region in which the combined effects of fluid 

viscosity and the no-slip condition produce a region of velocity transition adjacent 

to the wall. The thickness of the boundary layer increases until it equals the vessel 

radius (Figure 11). The entrance length Le increases with the Reynolds number. For 

laminar flows, Le is given approximately by: 

 

𝐿𝑒~0.03𝑅𝑒 𝐷  Eq. 12 

 

where D is the diameter [Secomb, 2017].  
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Figure 11. Development of boundary layer in fluid entering a pipe 

 

The assumptions mentioned above are violated in the circulatory system because 

blood is not a Newtonian fluid, arteries are curved, non-uniform and deformable, 

the flow is pulsatile and the velocity profile is rarely fully parabolic because of 

pulsatility, branching and decrease of the radius of the arteries approaching the 

extremities. Nevertheless, the use of Poiseuille’s law is widespread because it 

allows to obtain significant clinical results.  

 

  2.5 Wall Shear Stress  
 

Considering Poiseuille flow in a pipe, the equilibrium of forces acting on a generic 

cylindric volume of fluid with radius r, concentric with the pipe, subject to a 

pressure drop ΔP, can be expressed as follows: 

 

τ2πrL = ∆Pπ𝑟2  Eq. 13 
 

So, the shear stress τ is given by:  

 

τ =
∆𝑃𝑟

2𝐿
  Eq. 14 

 

The shear stress in the tube varies linearly with radial position, from zero at the 

center-line to a maximum value at the wall of the pipe, known as Wall Shear Stress 

(WSS). In the case under examination, the WSS is given by: 

 

WSS =
∆𝑃𝑅

2𝐿
  Eq. 15 

 

In the circulatory system, the wall shear stress is the tangential force per unit area 

the flowing blood exerts on the endothelial cells lining the vessel lumen and it is 

computed as the shear stress at the wall. The magnitude of WSS depends on how 

fast the fluid velocity increases when moving from the vessel wall toward the 

centre of the vessel. In fact, according to Poiseuille’s law, WSS can be expressed 
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as a function of the volume flow rate Q [Glagov et al., 1988; Secomb, 2017], as 

indicated in Eq. 16. 

WSS =  
4𝜇𝑄

𝜋𝑅3
  Eq. 16 

The spatial and temporal distribution of wall shear stress in arteries is sensitive to 

the geometry of the vessels as well as the pulsatile nature of the flow.  

The WSS is mainly applied to the inner layer of the arterial wall in contact with the 

blood, the vascular endothelium, whereas normal stresses due to blood pressure 

are transferred to all vessel wall layers (intima, media and adventitia) 

[Papaioannou and Stefanidis, 2005]. 

 

2.6 Hemodynamics role in atherosclerosis 
 

Atherosclerosis is associated with systemic risk factors including hypertension, 

smoking, hyperlipidemia, obesity and diabetes mellitus, that change the stiffness 

of arterial wall and lead to reduced artery compliance. Despite this, it is a focal 

disease, arterial atherosclerotic lesions are restricted to specific regions of the 

arterial tree, e.g. in the vicinity of branch points, the outer wall of bifurcations and 

the inner wall of curvatures, where disturbed flow occurs [Chatzizisis et al. 2007]. 

This suggests that hemodynamics and vessel geometry play a localizing role in the 

cause of plaque formation [Shaaban and Duerinckx, 2000]. In particular, 

atherosclerotic phenomena occur in vessels characterized by complex geometry 

and complex blood flow patterns [Gallo et al. 2014, Caruso et al. 2017].  

The magnitude and rate of blood flow close to a vessel wall, which can be 

expressed using the concept of WSS, have been linked to the pathogenesis of 

atherosclerosis [Shaaban and Duerinckx, 2000]. Several investigations suggested 

that low and oscillating wall shear stress and the presence of recirculation and 

flow separation regions, where wall shear stress is near zero, but shear stress 

gradient is high, promote atherosclerosis progression [Glagov et al. 1988, Giddens 

et al. 1993, Zarins et al. 1983, Friedman et al. 1987, Wasilewski et al. 2013]. By 

contrast, high unidirectional wall shear stress may exert a protective effect against 

the induction of atheromatous lesions [Glagov et al. 1988, Moore et al. 1994]. 

Endothelial cells that line arterial walls are equipped with numerous 

mechanoreceptors capable of detecting and responding to mechanical signals, 

such as the shear stress resulting from blood flow, generating biochemical signals 

that modify signalling pathways, and gene and protein expression through a 

mechanism known as mechanotransduction. Laminar, axially symmetric and fully 

developed flow velocity profiles activate atheroprotective genes, maintaining 
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normal endothelial function, whereas low and oscillatory shear stresses trigger 

unfavourable gene expression, leading to endothelial dysfunction. Shear flow 

without a defined direction causes molecular signalling of pro-inflammatory and 

proliferative pathways. So, the variations in shear stress patterns makes branched 

points and curved regions prone to atherogenesis, whereas the straight part of 

arterial tree, where the flow has relatively straight streamlines with well-defined 

direction, is generally protected against atherosclerosis [Wasilewski et al. 2013, 

Chatzizisis et al. 2007]. 

Both low and oscillatory wall shear stress contribute to an increased fluid 

residence time, that may result in unfavourable alterations in endothelial cell 

metabolism and in mass transport of atherogenic substances [Glagov et al. 1988].  

In fact, the prolonged residence time corresponds to a longer contact time of 

blood-borne particles that play a role in atherogenesis, such as platelets, 

macrophages and low density lipoproteins, with the artery wall [Pinto and 

Campos, 2016]. Consequently, the probability of retention and penetration of 

these flowing agents into the arterial wall increases [Chatzizisis et al. 2007].   

Moreover, since the endothelial cells are normally aligned and elongated in the 

direction of blood flow, marked oscillations in the direction of wall shear stress 

may cause a variation in the shape of endothelial cells, that become more 

polygonal without a preferred alignment pattern, a loss of stress fiber orientation 

and a lack of organization of the cytoskeleton. These morphological changes may 

be responsible for the widening of the junctions between endothelial cells. These 

gaps, in combination with the prolongation of the residence time of circulating 

particles, cause an increase in permeability to macromolecules such as 

lipoproteins, that lead to focal lipid accumulation under the endothelium [Ku et al. 

1985, Glagov et al. 1988, Chien S. 2008, Chatzizisis et al. 2007], and lead to vascular 

dysfunction including intimal hyperplasia, platelet activation, inflammatory 

reaction and reduced vasodilation [Hoi et al. 2011]. 

Furthermore, low wall shear stress reduces the bioavailability of nitric oxide, that 

possesses anti-inflammatory, anti-apoptotic, anti-mitogenic and anti-thrombotic 

properties, exposing the endothelium to the atherogenic effect of local and 

systemic risk factors [Chatzizisis et al. 2007]. 

The low-oscillatory shear theory has recently been debated because the co-

localization of atherosclerotic lesions with areas of low wall shear stress is far from 

perfect as well as several articles, that were assumed to assess the validity of these 

theory, showed discrepancies in methods and results. Peiffer et al. [Peiffer et al. 

2013a] made a systematic review of papers that investigated the correlation 

between atherosclerotic lesions prevalence and areas of low/oscillating wall shear 

stress and they concluded that the majority of the selected papers supported the 

consensus theory, but some contradicted it.  Therefore, they stated that ‘the 

evidence for the low-oscillatory shear theory is less robust than commonly 

assumed’.  
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More recently, temporal multidirectionality of haemodynamic stresses has been 

proposed as an important factor determining disturbed flow in arteries [Peiffer et 

al. 2013b].  The WSS does not remain parallel to a single axis throughout the 

cardiac cycle and the direction of WSS could influence the biology of endothelial 

cells, altering the balance between pro- and anti-atherosclerotic signals. So, the 

multidirectionality of near-wall flow is thought to be highly pro-atherogenic 

[Mohamied et al. 2015]. 

 

2.7 Carotid bifurcation 
 

Carotid arteries are two main blood vessels that carry oxygenated blood to the 

brain and facial areas. Right and left carotid arteries are paired arteries running up 

along either side of the front of the neck that branches into two divisions. The right 

common carotid artery originates in the neck from the brachiocephalic trunk, 

while the left one arises from the aortic arch in the thorax (Figure 12) [8]. Each 

common carotid artery (CCA) divides itself into external carotid artery (ECA), that 

provides blood to the face and neck, and internal carotid artery (ICA), which takes 

a deeper path to supply blood to the brain, (Figure 12, Figure 13) [9].  

 

 
Figure 12. Carotid arteries 

 

The carotid sinus, also known as carotid bulb, is a widening of a carotid artery at 

its branch point. This dilation involves the proximal portion of the ICA or the distal 

region of the CCA (Figure 13). 
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Figure 13. Carotid bifurcation  

 

As previously mentioned, vessel morphology plays a fundamental role in 

determining complicated patterns of fluid velocities and wall shear stresses in 

blood vessels. So, the complex geometry of human carotid bifurcation makes the 

velocity profiles markedly asymmetric.  

When a vessel curves, the change in flow direction involves a change in 

momentum, which is driven by a pressure gradient across the vessel cross-section, 

with higher pressure at the outside of the curve. The fluid near the centerline is 

driven outwards in the curve, whereas slower-moving fluid near the wall is driven 

toward the inside of the curve. As a consequence, blood velocity and wall shear 

stress are greater close to the outer wall than along the inner wall of the curvature. 

This sets up a secondary motion in the vessel cross-section, consisting of a pair of 

counter-rotating vortices called Dean vortices (Figure 15).  

Moreover, depending on the flow and the geometry, flow separation may occur 

in bifurcation areas, so, the streamlines of fluid moving adjacent to the wall 

separate from the wall and reattach at downstream points, leading to a region of 

recirculating flow, with reversed shear stress at the wall (Figure 14). Swirling flows 

may also occur in major arteries (Figure 14), leading to more uniform shear stress 

acting on arterial walls [Secomb, 2017] and suppressing disturbed flow. So, helical 

flow can modify near-wall transport topology, reducing the accumulation of 

atherogenic substances on the vessel wall and therefore protecting against 

atherosclerosis [Arzani and Shadden, 2016]. 
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Figure 14. Blood velocity pattern in a carotid bifurcation 

 

All the above-mentioned phenomena determine disturbed flow conditions in the 

carotid bifurcation and especially in the carotid bulb (Figure 15), making it a 

common site of atherosclerosis appearance. The regions close to the flow divider 

are characterized by with higher blood velocities and shear stresses (Figure 15). 

On the opposite sides of the vessel, the velocities and wall shear stresses are much 

lower (Figure 15). Furthermore, the flow is typically unidirectional and laminar 

throughout the cardiac cycle at the inner wall on the flow divider side, whereas 

lateral wall is a region of flow separation, formation of complex flow patterns and 

vortices. So, the outer wall of the proximal segment and sinus of the ICA are 

preferential sites for atherosclerotic plaque formation [Glagov et al. 1988]. 

 

 
Figure 15. Flow phenomena occurring in a human carotid bifurcation 
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Chapter 3. Hemodynamic wall descriptors 

A variety of hemodynamic wall parameters (HWPs) has been proposed over the years 

to quantify haemodynamic disturbances as potential predictors or indicators of 

vascular wall dysfunction [Lee et al. 2009]. These descriptors reduce the complexity of 

the four-dimensional blood flow field, aid the prediction of disturbed flow conditions 

in the vessels and play a significant role in the detection of potential zones of 

atherosclerosis development. 

For the aforementioned reasons, the majority of haemodynamic parameters are based 

on the wall shear stress. The most used HWPs are the followings: 

 

3.1 TAWSS: Time Averaged Wall Shear Stress 
 

𝑇𝐴𝑊𝑆𝑆 =  
1

𝑇
∫ |𝑾𝑺𝑺|

𝑇

0
𝑑𝑡  Eq. 17 

 

where T is the cardiac cycle period, during which the WSS vector is measured, 

and t is the time.  

The Time Averaged Wall Shear Stress evaluates the total shear stress exerted 

on the wall throughout a cardiac cycle. Low TAWSS values (lower than 0.4 Pa), 

which are typically associated with disturbed flow regions, where the flow is 

slow and changes direction within the cardiac cycle, stimulate atherogenic 

phenotype, moderate TAWSS values (between 1.5 Pa and 10 Pa) induce 

endothelial quiescence and an atheroprotective gene expression profile 

[Malek et al. 1999, Dolan et al. 2013], high TAWSS values (greater than 10-15 

Pa) can lead to endothelial trauma and haemolysis [Gallo et al. 2014] and to 

plaque destabilization and ulceration in stenosed vessels [Sousa et al. 2014; 

Dolan et al. 2013]. 

 

3.2 OSI: Oscillatory Shear Index 
 

𝑂𝑆𝐼 = 0.5 [1 − (
|∫ 𝑾𝑺𝑺𝑑𝑡

𝑇

0
|

∫ |𝑾𝑺𝑺|𝑑𝑡
𝑇

0

)]  Eq. 18 

 

The Oscillatory Shear Index is a dimensionless metric that accounts for the 

deviation of the WSS from its average direction, identifying regions on the 

vessel wall subjected to highly oscillating WSS, that may induce perturbed 

endothelial cells alignment and consequently plaque formation. In fact, during 

the cardiac cycle the WSS vector transiently alternates between the positive 

and negative axial directions.  
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This descriptor ranges from a minimum of zero, indicating a unidirectional WSS, 

to a maximum of 0.5, highlighting a purely oscillatory WSS. However, the OSI 

does not distinguish between uniaxial reversing flow from multidirectional flow 

[Mohamied et al. 2015].  Moreover, OSI is insensitive to shear magnitude, so it 

might be better employed in combination with other shear measures. 

 

3.3 RRT: Relative Residence Time 
 

𝑅𝑅𝑇 =
1

|∫ 𝑾𝑺𝑺𝑑𝑡
𝑇

0
|
~

1

(1−2𝑂𝑆𝐼)𝑇𝐴𝑊𝑆𝑆
  Eq. 19 

 

The Relative Residence Time is proportional to a combination of TAWSS and 

OSI, so it provides a single measure of low and oscillatory WSS [Lee et al. 2009].  

RRT measures how long the particles stay near the vessel wall, it should take a 

value between 0 and infinite, so elevated RRT value (higher than 8 Pa-1), that 

corresponds to low TAWSS and high OSI, indicates a potential zone of 

atherosclerosis appearance [Pinto and Campos, 2016].  

The descriptors quantifying low and oscillatory wall shear stress are significant, 

but moderately weak predictors of vascular wall dysfunction [Gallo et al., 2016]. 

As said above, some studies showed that multidirectionality of WSS during the 

cardiac cycle may be a more significant factor, well correlated with the biological 

response of endothelial cells. TAWSS, OSI and RRT indices are unable to distinguish 

between uniaxial pulsatile flow and multidirectional flow. So, to capture the 

temporal multidirectionality of the near-wall blood flow field, Peiffer et al. [Peiffer 

et al. 2013b] proposed a new metric, the transverse Wall Shear Stress, whereas 

Morbiducci et al. [Morbiducci et al. 2015] introduced the axial Wall Shear Stress. 

 

3.4 transWSS: transverse Wall Shear Stress 
 

𝑡𝑟𝑎𝑛𝑠𝑊𝑆𝑆 =
1

𝑇
∫ |𝑾𝑺𝑺 (𝒏 ×

∫ 𝑾𝑺𝑺𝑑𝑡
𝑇

0

|∫ 𝑾𝑺𝑺𝑑𝑡
𝑇

0
|
)| 𝑑𝑡

𝑇

0
  Eq. 20 

 

where n represents the normal to the arterial surface.  

The transverse Wall Shear Stress is the time-average of the components of the 

instantaneous WSS vector that are perpendicular to the mean flow direction, 

with which endothelial cells are assumed to align. The definition of this 

parameter is supported by the hypothesis that endothelial cells may be 

adversely affected by cross-flow [Mohamied et al. 2017]. TransWSS can take 

any value between zero and the TAWSS. A low transWSS indicates that the flow 

remains approximately parallel to a single axis throughout the cardiac cycle, 

while a high transWSS indicates large changes in flow direction, or smaller 
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changes in direction over a large portion of the cardiac cycle, or small changes 

in the direction of high-speed near wall flow. TransWSS distinguishes between 

uniaxial and multidirectional flows, but it does not differentiate between 

purely forward flow and reversing unidirectional flow, both of which have a 

transWSS of zero, so it can only complement TAWSS, OSI and RRT, rather than 

replace them [Peiffer et al. 2013b]. Moreover, transWSS cannot be defined if 

there is not a dominant flow direction, as in the theoretical case of purely 

oscillatory flow.  

Mohamied et al. [Mohamied et al. 2015] demonstrated that transWSS changes 

with age, in agreement to the variation of stresses and the evolution of the 

pattern of atherosclerotic lesion prevalence that occur from immature to 

mature age around branch ostia of rabbit aortas. 

 

3.5 CFI: Cross Flow Index  
 

The instantaneous cross flow index (CFi), defined at the i-th time point, was 

introduced by Mohamied et al. [Mohamied et al. 2017] as the ratio between 

instantaneous transWSS and WSS, as specified below: 

 

CFI𝑖 =
𝑡𝑟𝑎𝑛𝑠𝑊𝑆𝑆𝑖

𝑊𝑆𝑆
=

𝑾𝑺𝑺

|𝑾𝑺𝑺|
∙ (𝒏 ×

∫ 𝑾𝑺𝑺𝒅𝒕
𝑻

𝟎

|∫ 𝑾𝑺𝑺𝒅𝒕
𝑻

𝟎
|
) Eq.21 

 

It represents the directionality of WSS, being the sine of the angle between 

the cycle-averaged WSS vector and the instantaneous WSS vector. Time-

averaging these instantaneous values over the cardiac cycle, the Cross Flow 

Index can be obtained as: 

 

CFI =
1

𝑇
∫

𝑾𝑺𝑺

|𝑾𝑺𝑺|
∙ (𝒏 ×

∫ 𝑾𝑺𝑺𝒅𝒕
𝑻

𝟎

|∫ 𝑾𝑺𝑺𝒅𝒕
𝑻

𝟎
|
) 𝑑𝑡

𝑇

0
  Eq. 22 

 

Mohamied et al. [Mohamied et al. 2017] used two geometries of immature 

rabbit thoracic aortas and demonstrated that CFIi is high when the flow is 

nearly stagnant, for example during diastole, it reaches its maximum value in 

case of flow reversal, whereas CFI is at its lowest at peak systole, when the 

WSS is maximal. Indeed, portions of the cardiac cycle where the WSS is highest 

influence mostly the cycle-averaged WSS, so in these parts of the cycle the 

instantaneous WSS vector deviates least from the temporal mean WSS vector, 

and consequently CFI is low. 
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3.6 WSSax: Axial Wall Shear Stress  
 

The Axial Wall Shear Stress [Morbiducci et al. 2015] is a metric for the analysis 

of WSS temporal multidirectionality that defines a different preferential flow 

direction with respect to that proposed by Peiffer et al. [Peiffer et al. 2013b]. 

Morbiducci et al. used the streamwise axis of the vessel, instead of the cycle-

averaged WSS vector direction. This choice could be helpful in regions of 

complex flow, where there is no predominant WSS direction.  

More in detail, Morbiducci et al. [Morbiducci et al. 2015] defined the Axial 

Wall Shear Stress at every point on the vascular surface as the projection of 

WSS vector along the direction C’ of the tangent to the centerline (i.e. the set 

of the points computed as the centres of maximal spheres inscribed in the 

vessel lumen) of the vessel, as illustrated by the following equation: 

 

𝑊𝑆𝑆𝑎𝑥 =
𝑾𝑺𝑺∙𝑪′

|𝑪′|

𝑪′

|𝑪′|
  Eq. 23 

 

WSSax is a signed quantity, that assumes a positive value when the axial WSS 

projection is aligned with the centerline and directed with forward flow, while 

it is negative when the flow is reversed. A null WSSax identifies regions with no 

predominant direction of axial WSS, where flow separation occurs.    

 

3.7 WSSG: Wall Shear Stress Spatial Gradient 
 

𝑊𝑆𝑆𝐺 =  
1

𝑇
∫ √(

𝜕𝑊𝑆𝑆𝑝

𝜕𝑝
)

2

+ (
𝜕𝑊𝑆𝑆𝑛

𝜕𝑛
)

2𝑇

0
𝑑𝑡  Eq. 24 

 

where p and n are respectively the directions parallel and normal to the 

direction of the time-average WSS vector.  

The Wall Shear Stress Spatial Gradient is the spatial derivative of WSS along the 

flow direction with respect to the streamwise distance and it may be 

considered a marker of endothelial cell tension. [Lee et al. 2009]. The WSSG of 

fully-developed flow in a straight uniform pipe is zero. Positive WSSG 

(increasing WSS along the flow direction) inhibits while negative WSSG 

promotes flow-induced endothelial cells alignment [Dolan et al. 2013]. Large 

endothelial spatial gradients produce an increase in wall permeability [Arzani 

and Shadden, 2016] and endothelium dysfunction due to spatially changing 

hemodynamic forces [Gallo et al. 2014]. 

 



29 
 

3.8 WSSAG: Wall Shear Stress Angle Gradient  
 

𝑊𝑆𝑆𝐴𝐺 =  
1

𝑇

𝐷

𝜋
∫ |∇𝛷𝑛|𝑑𝑡

𝑇

0
  Eq. 25 

 

where D is the vessel diameter and  

 

𝛷𝑛 = arccos (
𝑊𝑆𝑆𝑖𝑊𝑆𝑆𝑗

|𝑊𝑆𝑆𝑖||𝑊𝑆𝑆𝑗|
)  Eq. 26  

 

is the scalar field of the WSS angle deviation, where WSSi is the vector at the 

location of interest and WSSj represents the surrounding stress vectors (shear 

and normal stress).  

The Wall Shear Stress Angle Gradient is a mesh-independent measure of the 

angle between adjacent wall shear vectors, it highlights regions exposed to 

large spatial variations in the mean WSS direction, irrespective of magnitude 

[Lee et al. 2009], as regions of flow separation and flow reattachment, so it has 

been proposed as a marker for sites of possible dysfunctional endothelial cells 

[Augst et al. 2007]. Elevated WSSAG values may lead to changes in endothelial 

cell architecture, increase in cell turnover linked to enhanced wall 

permeability, and development of arterial disease at particular sites [Hyun et 

al. 2002]. 

 

3.9 WSST: Wall Shear Stress Temporal gradient 
 

𝑊𝑆𝑆𝑇 = 𝑚𝑎𝑥 (|
𝜕|𝑾𝑺𝑺|

𝜕𝑡
|)  Eq. 27 

 

The Wall Shear Stress Temporal gradient is the maximum absolute rate of 

change in WSS magnitude over the cardiac cycle [Lee et al. 2009] at each spatial 

position in the domain. 

White et al. demonstrated that temporal gradients in shear stress stimulate 

endothelial cell proliferation [White et al. 2001]. Intimal thickening caused by 

the mitogenic effect of high focal WSST, combined with cell-disorientation and 

widening of junctions in the endothelium are regarded as possible initiators to 

atherogenesis in regions of recirculation. The combination of high WSST with 

elevated RRT values could enhance the diffusion of atherogenic substances in 

combination with high residence times. So, peak temporal WSS gradient has 

been proposed as a complementary parameter for the detection of plaque 

prone regions in complex geometries [Van Wick et al. 2014]. 

According to the study carried out by Lee et al. on carotid bifurcations, [Lee et 

al. 2009] elevated values of WSS temporal gradient are concentrated around 

the bifurcation apex, that is usually not subject to atherosclerosis.  
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The frequency content of shear variations that occur over a cardiac cycle may also 

be a contributing factor in lesion development. So, some hemodynamic 

parameters based on the harmonic content of the shear stress waveform have 

been proposed recently. 

 

3.10 DH: Dominant Harmonic 
 

𝐷𝐻 = max (𝐹|𝑾𝑺𝑺| (𝑛
2𝜋

𝑇
)) , 𝑛 ∈  𝑁+  Eq. 28 

 

where F|WSS| is the Fourier transform of the time-varying waveform of the WSS 

magnitude and n is a positive integer.  

The Dominant Harmonic is thus defined as the highest harmonic obtained 

through the Fourier decomposition of the WSS along the cardiac cycle [Gallo et 

al. 2014].  

Himburg and Friedman demonstrated that, while most of the arteries 

experienced shear forces predominantly at the frequency of the heart rate 

(that is the first harmonic), the frequency spectra at certain regions were 

dominated by shear forces at higher frequencies. More in detail, they found in 

porcine iliac artery an inverse relationship between TAWSS and DH, suggesting 

that complex vascular regions, where the WSS is low, are dominated by higher 

harmonics [Himburg and Friedman, 2006]. 

 

3.11 HI: Harmonic Index 
 

𝐻𝐼 =  
∑ 𝐹|𝑾𝑺𝑺|(𝑛

2𝜋

𝑇
)∞

𝑛=1
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𝑇
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, 𝑛 ∈ 𝑁+  Eq. 29 

 

The Harmonic Index is a measure of the relative fraction of the harmonic 

amplitude spectrum arising from the pulsatile flow component. It ranges from 

zero, in the case of a steady nonzero shear stress signal, to 1, in the case of 

purely oscillatory signal with a time average of zero. The harmonic index 

colocalizes with OSI, confirming a relationship between specific frequency 

components and atherosclerosis development [Gelfand et al. 2006]. 

 

Lee et al. made an evaluation of correlations among HWPs at the normal carotid 

bifurcation, demonstrating that some of these parameters may be considered 

redundant. More in detail, the three magnitude-based HWPs (TAWSS, OSI and 

RRT) were strongly correlated, suggesting RRT as a single marker of low and 

oscillatory WSS, with a tangible connection to the biological mechanisms 

underlying atherosclerosis. WSSG and WSST showed a moderate positive 
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correlation with TAWSS, which suggests that TAWSS could be used instead of 

gradient-based HWPs, that are more susceptible to measurement uncertainty. The 

harmonic-based parameter HI was moderately correlated with the three 

magnitude-based parameters, while DH was only weakly correlated with other 

HWPs, showing to be essentially independent of the others HWPs [Lee et al. 2009]. 

Lastly, Gallo et al. demonstrated that the multidirectionality descriptor transWSS 

is not colocalized with OSI. It may represent different hemodynamic disturbances 

at the carotid bifurcation, with a different impact on endothelial cells [Gallo et al. 

2016], so it could complement the information given by magnitude-based HWPs. 
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Chapter 4. Methods 

 
In this work, new haemodynamic descriptors based on the wall shear stress divergence 

have been investigated. The analysis was performed on forty-six image-based carotid 

bifurcation models. Aim of this study was to verify if these parameters could be useful 

to atherosclerosis prediction and if they are correlated with the existing well-

established HWPs. To do it, an analysis of the co-localization of these parameters was 

carried out. 

 

4.1 Computational fluid dynamics modelling  
 

Data used in this study are a subset selected from the “Vascular Aging - The Link 

That Bridges Age to Atherosclerosis” validate study. The right carotid artery 

geometries of seemingly healthy participants were acquired from contrast-

enhanced angiography (CEMRA). In a study by [Gallo et al. 2015] lumen 

geometries were reconstructed from their brachiocephalic origin to well above the 

bifurcation using the open-source Vascular Modelling Toolkit VMTK. To ensure 

fully developed velocity profiles at the CCA inlet and to minimize the influence 

from outlet boundary conditions, flow extensions were added to the inlet and 

outlet faces of all models. Computational fluid dynamics simulations were carried 

out by Gallo et al. [Gallo et al. 2016] following the methods described in [Hoi et al. 

2010]. The finite volume method was adopted to solve the governing equations of 

the fluid motion. More in detail, tetrahedral element meshes were generated by 

ANSYS ICEM-CFD software with a node spacing of 0.1-0.2 mm, which was 

previously shown to successfully resolve wall shear stresses at normal carotid 

bifurcation geometries. Inlet and outlet velocities were acquired from phase 

contrast magnetic resonance (PCMRI) sequences. So, fully developed, pulsatile, 

patient-specific velocity profile boundary conditions were imposed at the CCA 

inlet and ICA outlet. Traction-free boundary conditions were imposed at the ECA 

outlet. Rigid walls and Newtonian rheology with constant blood viscosity of 

0.00371 kg/m*s were assumed for all models. The CFD simulations were carried 

out using 4800 time steps per cardiac cycle. 

 

4.2 Wall shear stress divergence 
 

The divergence (∇ ∙) is a vector operator which takes as input a vector-valued 

function defining a vector field and outputs a scalar-valued function [5] measuring 

the overall tendency of the field to converge toward or diverge from a point 

[Saenz, 2013]. The divergence measures the flux of a tangent vector field 

throughout an infinitesimal region of space around each point [De Goes et al. 
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2015]. If the vector field points outward from a point, its divergence would have a 

positive value in that region (Figure 16, Panel B). In contrast, if the vector field 

moves toward a point, then the divergence has a negative value (Figure 16, Panel 

A) [6]. This physical interpretation allows to use divergence to identify sources 

(points of positive divergence) and sinks (points of negative divergence) of a vector 

field [5]. The net flow outwards from a region is given by the sum of all sources 

minus the sum of all sinks. So, if the divergence at a point is zero (Figure 16, Panel 

C), then any infinitesimal closed surface around that point has no net flow across 

it [7]. If a vector field has zero divergence everywhere, it is called incompressible 

or solenoidal. 

 

Figure 16. Physical interpretation of the divergence of a vector field �⃗�: A) Sink B) Source C) Point with zero 
divergence 

 

Given the three-dimensional tangent vector field representing the wall shear 

stress written in cartesian coordinates (WSS=WSSxi +WSSyj +WSSzk), the Wall 

Shear Stress divergence is a scalar-valued function defined as described by Eq. 30: 

 

∇ ∙ 𝐖𝐒𝐒 =
𝜕𝑊𝑆𝑆𝑥

𝜕𝑥
+

𝜕𝑊𝑆𝑆𝑦

𝜕𝑦
+

𝜕𝑊𝑆𝑆𝑧

𝜕𝑧
  Eq. 30 

 

Where ∇ ∙ 𝐖𝐒𝐒 = (
𝜕

𝜕𝑥
,

𝜕

𝜕𝑦
,

𝜕

𝜕𝑧
) ∙ (𝑊𝑆𝑆𝑥, 𝑊𝑆𝑆𝑦, 𝑊𝑆𝑆𝑧) is the “dot product” 

between the gradient operator ∇ and the component functions of WSS. 

As previously said, the endothelial cells lining blood vessels respond to both 

magnitude and directional changes of WSS. The above-mentioned haemodynamic 

wall parameter called OSI is able to identify regions subjected to oscillating WSS, 

but it cannot distinguish tensile from compressive force. So, to consider both the 

magnitude and the directionality of WSS, Zhang et al. proposed the use of wall 

shear stress divergence as a parameter to predict the aneurysm rupture. Wall 

shear stress divergence takes into account the gradient and the direction of WSS 
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and can be used to identify tensile and compressive regions on the aneurysm 

surface [Zhang et al. 2013].  

According to this view, WSS divergence could also be helpful to highlight WSS 

directionality and the oscillatory behaviour of wall shear stress in vascular regions 

that could be affected by atherosclerotic plaque formation. 

A positive value of WSS divergence at a point identifies an expansion at that 

region, and in this case the net effect of WSS is to stretch the vascular surface, 

otherwise WSS compresses the endothelial layer. The magnitude of WSS 

divergence represents the intensity of stretching or compression [Zhang et al. 

2013].  

 

4.3 Wall shear stress divergence computation 
 

The available forty-six carotid bifurcation surfaces were discretized with triangle 

meshes made-up of about 4,000,000 elements. To obtain a discrete 

representation of the wall shear stress vector field on the vascular surfaces, a 

vertex-based representation was chosen. The wall shear stress tangent vector 

field was described through three values WSSx, WSSy, WSSz (one for each 

coordinate) on each vertex of the triangles. Given the coordinates of the vertices 

at which the vector field was sampled, the values of the three components of WSS 

were defined on the nodes of every grid storing a scalar field for each coordinate.  

The WSS vector field components were defined over each triangle utilizing a 

piecewise-linear interpolation. The three values associated to each mesh vertex 

were interpolated linearly inside each triangle: 

 

𝑊𝑆𝑆(𝑥) = (𝑊𝑆𝑆𝑥)𝑖𝐵𝑖(𝑥) + (𝑊𝑆𝑆𝑥)𝑗𝐵𝑗(𝑥) + (𝑊𝑆𝑆𝑥)𝑘𝐵𝑘(𝑥) Eq. 31 

𝑊𝑆𝑆(𝑦) =  (𝑊𝑆𝑆𝑦)𝑖𝐵𝑖(𝑦) + (𝑊𝑆𝑆𝑦)𝑗𝐵𝑗(𝑦) + (𝑊𝑆𝑆𝑦)𝑘𝐵𝑘(𝑦)         Eq.32 

𝑊𝑆𝑆(𝑧) =  (𝑊𝑆𝑆𝑧)𝑖𝐵𝑖(𝑧) + (𝑊𝑆𝑆𝑧)𝑗𝐵𝑗(𝑧) + (𝑊𝑆𝑆𝑧)𝑘𝐵𝑘(𝑧) Eq. 33 

 

The vertices of each triangle are indicated with the letters i, j and k respectively. 

Bi, Bj and Bk are linear basis functions, whose linear combination allows to 

interpolate every continuous function. 

It follows that the gradients of the components of WSS can be obtained by 

differentiating these vertex-based basis functions, as described by Equations 34, 

35 and 36. 
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∇WSS(x) = (𝑊𝑆𝑆𝑥)𝑖∇𝐵𝑖(𝑥) + (𝑊𝑆𝑆𝑥)𝑗∇𝐵𝑗(𝑥) + (𝑊𝑆𝑆𝑥)𝑘∇𝐵𝑘(𝑥) Eq. 34 

∇WSS(y) = (𝑊𝑆𝑆𝑦)𝑖∇𝐵𝑖(𝑦) + (𝑊𝑆𝑆𝑦)
𝑗
∇𝐵𝑗(𝑦) + (𝑊𝑆𝑆𝑦)

𝑘
∇𝐵𝑘(𝑦) Eq. 35 

∇WSS(z) = (𝑊𝑆𝑆𝑧)𝑖∇𝐵𝑖(𝑧) + (𝑊𝑆𝑆𝑧)𝑗∇𝐵𝑗(𝑧) + (𝑊𝑆𝑆𝑧)𝑘∇𝐵𝑘(𝑧) Eq. 36 

 

More in detail, referring to Figure 17, ∇𝐵𝑖(𝑥) is given by: 

 

∇𝐵𝑖(𝑥) =
1

ℎ(𝑡)
=

(𝑥𝑘−𝑥𝑗)
⊥

2𝐴𝑇
  Eq. 37 

 

 

Figure 17. Triangle of the mesh and linear basis function differentiation. 

 

Analogous calculi allow the differentiation of the other linear basis functions. 

So, the gradients of WSS were computed in each triangle, along the directions of 

the cartesian space, according to the following equations, in Matlab (The 

MathWorks Inc.) software: 

 

∇WSS(x) =
(𝑊𝑆𝑆𝑥)𝑖

2𝐴𝑇
(𝑥𝑘 − 𝑥𝑗)

⊥
+

(𝑊𝑆𝑆𝑥)𝑗

2𝐴𝑇
(𝑥𝑖 − 𝑥𝑘)⊥ +

(𝑊𝑆𝑆𝑥)𝑘

2𝐴𝑇
(𝑥𝑗 − 𝑥𝑖)

⊥
             Eq. 38 

∇WSS(y) =
(𝑊𝑆𝑆𝑦)𝑖

2𝐴𝑇
(𝑦𝑘 − 𝑦𝑗)

⊥
+

(𝑊𝑆𝑆𝑦)𝑗

2𝐴𝑇
(𝑦𝑖 − 𝑦𝑘)⊥ +

(𝑊𝑆𝑆𝑦)𝑘

2𝐴𝑇
(𝑦𝑗 − 𝑦𝑖)

⊥
            Eq. 39 

∇WSS(z) =
(𝑊𝑆𝑆𝑧)𝑖

2𝐴𝑇
(𝑧𝑘 − 𝑧𝑗)

⊥
+

(𝑊𝑆𝑆𝑧)𝑗

2𝐴𝑇
(𝑧𝑖 − 𝑧𝑘)⊥ +

(𝑊𝑆𝑆𝑧)𝑘

2𝐴𝑇
(𝑧𝑗 − 𝑧𝑖)

⊥
              Eq. 40 

 

Where the single triangle ijk has an area AT and three vertices with coordinates (xi, 

yi, zi), (xj, yj, zj) and (xk, yk, zk), respectively. So, (WSSx)i represents the x-component 

of the WSS in the node i, (𝑥𝑘 − 𝑥𝑗)
⊥

 indicates the vector having length equal to 
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the edge connecting nodes k and j, and direction perpendicular to it, and so on, as 

depicted in Figure 18. 

 

Figure 18. Generic triangle of the mesh with auxiliary vectors for the computation of WSS gradient. 

 

Then, the divergence of wall shear stress was computed inside every triangle as 

the sum of the WSS gradients along the three spatial directions, as specified 

below: 

 

∇ ∙ 𝐖𝐒𝐒 =  ∇WSS(x) + ∇WSS(y) + ∇WSS(z)  Eq. 41 

 

Lastly, the divergence of the wall shear stress was evaluated at the nodes of the 

triangle mesh. Specifically, at the n-th node of the grid, ∇ ∙WSS was computed as 

the weighted average of the wall shear stress divergence values in all the t 

triangles that shared that node, as analytically described in the following equation: 

 

∇ ∙ 𝐖𝐒𝐒(n) =
∑ ∇∙𝑾𝑺𝑺(𝑚)𝑡

𝑚=1

𝑡
  Eq. 42 
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For example, ∇ ∙WSS in the node n in Figure 19 is given by 

∇ ∙WSS(n)= 
∑ ∇∙𝐖𝐒𝐒(m)5

𝑚=1

5
. 

 

Figure 19. Example of computation of divWSS in a node of the mesh. 

 

The wall shear stress divergence scalar field was thus specified at the mesh nodes.  

 

4.4 Normalized WSS vector field divergence 
 

The divergence of WSS vector field takes into account both the magnitude and the 

direction of WSS. So, considering the value of the divergence of WSS vector field, 

it is not possible to distinguish if a positive value of ∇ ∙WSS is due to the source 

arrangement of WSS field (Figure 20, panel A) or to an increase in WSS magnitude 

(Figure 20, panel B), and analogously if a negative ∇ ∙WSS value is owed to a WSS 

field with sink configuration (Figure 20, panel C) or to a decrease in WSS magnitude 

(Figure 20, panel D). Moreover, a WSS vector field that has a uniform direction but 

variable magnitude of WSS vectors (Figure 20, panels B and D), is characterized by 

a nonzero ∇ ∙WSS value.   

 

Figure 20. WSS field configurations: A) and B) positive divergence; C) and D) negative divergence 
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So, in this work, the values of WSS components were divided by their moduli, with 

the aim to obtain unit vectors over the entire surface. Then, it was computed the 

divergence of the normalized WSS vector field (Eq. 43) at the nodes of each carotid 

bifurcation surface, with the methods described in the previous paragraph. This 

choice allows to make an evaluation of the WSS directionality, neglecting the 

variations in WSS magnitude.  

𝑑𝑖𝑣𝑊𝑆𝑆 =  ∇ ∙ (
𝑾𝑺𝑺

|𝑾𝑺𝑺|
)  Eq. 43 

 

4.5 WSS divergence-based parameters 
 

In this work, the cardiac cycle was divided into 120 time steps and they were 

computed the values that the divergence of the normalized wall shear stress takes 

at these instants. To synthetize the temporal information, it was considered the 

temporal average of the WSS divergence over the cardiac cycle, as described by 

the following equation:  

 

𝑑𝑖𝑣𝑊𝑆𝑆̅̅ ̅̅ ̅̅ ̅̅ ̅̅ ̅ =
1

𝑇
∫ ∇ ∙ (

𝑾𝑺𝑺

|𝑾𝑺𝑺|
)

𝑇

0
𝑑𝑡  Eq. 44 

 

where T is the cardiac period. 

Three novel parameters based on wall shear stress divergence were then 

considered:  

▪ Positive WSS Divergence (DivP); 

▪ Negative WSS Divergence (DivN);  

▪ Oscillatory WSS Divergence Index (ODI). 

DivP was defined as an array containing the values of 𝑑𝑖𝑣𝑊𝑆𝑆̅̅ ̅̅ ̅̅ ̅̅ ̅̅ ̅ in correspondence 

of the nodes in which the temporal average of the divergence of the normalized 

WSS is positive, otherwise zero. Analogously, DivN is an array containing the values 

of 𝑑𝑖𝑣𝑊𝑆𝑆̅̅ ̅̅ ̅̅ ̅̅ ̅̅ ̅ in correspondence of the nodes of the model characterized by a 

negative mean value of divWSS, zero values in correspondence of the other nodes. 

To account for the temporal changes of WSS divergence, ODI was computed in 

each node as the standard deviation of divWSS over the cardiac cycle (Eq. 45). 

 

ODI =
√∑ ((∇∙

𝑾𝑺𝑺

|𝑾𝑺𝑺|
)

𝑖
− 𝑑𝑖𝑣𝑊𝑆𝑆̅̅ ̅̅ ̅̅ ̅̅ ̅̅ ̅)

2
𝑁
𝑖=1

𝑁−1
  Eq. 45 
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DivP is capable of capturing regions of the vessel that are stretched by a shear 

stress with a source configuration, whereas DivN can highlight areas where the 

wall shear stress assumes a sink arrangement, compressing the vessel wall. On the 

other hand, ODI identifies vessel regions that are exposed to a wall shear stress 

that alternatively diverges and converges.  

The definition of ODI is clarified by the observation that a high value of the 

standard deviation corresponds to large fluctuations of divWSS value during the 

cardiac cycle. Analysing the values taken by the divergence during the cardiac cycle 

in every node, it was observed that divWSS exhibit nearly-normal probability 

density distributions for all the forty-six carotid bifurcation models. An example of 

the probability density estimates of divWSS values taken during the cardiac cycle 

in all the nodes of a specific model is shown in Figure 21, whereas in Figure 22 are 

reported the probability density estimates of the spatial averages of divWSS values 

taken during the cardiac cycle for all the 46 carotid models.  

 

Figure 21. Probability density estimates of divWSS values taken during the cardiac cycle in the nodes of one of the 
carotid bifurcation models. 

 

The values of the divergence of the normalized WSS are roughly symmetrically-

distributed around the mean value, that is close to zero for all the considered 

carotid bifurcations (Figure 22). So, if a region is exposed to a large divWSS 

standard deviation, it can be subject to sign variations of divWSS during the cardiac 

cycle. Then, high ODI values can describe alternating directional changes of the 

WSS. That is to say, the tangential stress acting on the regions of the luminal 

surface where ODI takes high values may switch repeatedly between tensile and 

compressive throughout the whole cardiac cycle.  
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To verify that the information given by the ODI was actually related to the 

oscillations between positive and negative values of the divergence of the 

normalized wall shear stress, a counter was introduced. It counts the number of 

consecutive sign changes of the divWSS over the 120 time steps in which the 

cardiac cycle was divided, and it was computed at all the nodes of every model. 

 

Figure 22. Probability density estimates of the spatial averages of divWSS values taken during the cardiac cycle for 
all the 46 carotid bifurcation models 

 

4.6 Co-localization analysis 
 

To compare the distributions of the new haemodynamic descriptors based on wall 

shear stress divergence to the arrangements of established haemodynamic wall 

parameters on the luminal surface of the carotid bifurcation models, in this work 



41 
 

it was used a methodology that is analogous to the procedure employed in [Gallo 

et al. 2016]. More in detail, starting from the lumen geometries of the forty-six 

carotid bifurcations reconstructed in VMTK by [Gallo et al. 2015], the centerlines 

of the vessels were generated in VMTK (Figure 23). 
  

 

Figure 23. Example of generation of the centerline of a vessel in VMTK 

 

Then, to delimit the bifurcation regions, that are the areas of interest with regard 

to atherosclerosis appearance, and to remove the flow extensions, each model 

was cut at sections located at 3, 5 and 2 maximally inscribed spheres radii from 

the bifurcation along the Common Carotid Artery, Internal Carotid Artery and 

External Carotid Artery, respectively (Sections CCA3, ICA5 and ECA2, Figure 24). 
 

 

Figure 24. Example of cut of a bifurcation region along the sections CCA3, ICA5 and ECA2 
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The distributions of seven established haemodynamic wall parameters (TAWSS, 

OSI, RRT, CFI, WSSax and transWSS computed in a work by [Gallo et al. 2016] and 

WSST computed in this work hypothesizing a cardiac frequency of 75 beats per 

minute), of three new divergence-based parameters (DivP, DivN and ODI) and of 

the values taken by the counter were projected onto the luminal surfaces of the 

bifurcation regions that were isolated from the entire vessels as described above. 

For all the listed descriptors, threshold values were computed. Specifically, being 

disturbed flow regions associated with low TAWSS values, high OSI, RRT, 

transWSS, WSST and CFI values, and negative WSSax values, the threshold for 

TAWSS was the 20th percentile value, computed as the value of TAWSS under 

which the 20% of the merged surfaces of all the cut models was exposed to, 

whereas the 80th percentile values, under which the 80% of the overall cut surfaces 

were exposed to, were computed for OSI, RRT, CFI, transWSS and WSST, the zero 

value was taken as the WSSax threshold value instead. As regards the divergence-

based haemodynamic wall parameters, for DivN and DivP the 20th and the 80th 

percentile values of divWSS̅̅ ̅̅ ̅̅ ̅̅ ̅̅  were considered as the threshold values respectively, 

whereas the 80th percentile value was taken as ODI threshold value. Lastly, for the 

counter it was computed the 80th percentile value.  

To each node n of the models was associated an area An that was computed as 

one third of the summation of surface areas of all the t triangles that converged at 

that node: 

𝐴𝑛 =
1

3
∑ 𝐴(𝑚)𝑡

𝑚=1    Eq. 46 

 

The total area of the luminal surface of the bifurcation was calculated as the sum 

of the areas assigned to all the nodes of the model. Then, in order to quantify the 

disturbed flow, the relative surface areas, denoted respectively with the names 

TAWSS20, WSSax_0, OSI80, RRT80, CFI80, transWSS80, WSST80, DivP80, DivN20, 

ODI80 and Counter80 were computed for every carotid bifurcation. These relative 

surface areas were obtained as the ratios between the surface areas that were 

exposed to TAWSS, WSSax and DivN below, OSI, RRT, CFI, transWSS, WSST, DivP, 

ODI and Counter above their respective threshold values and the total area of the 

bifurcation.  

The analysis of the co-localization of new divergence-based parameters with the 

established haemodynamic descriptors in the carotid bifurcations was performed 

through the evaluation of the similarity indices, as described in [Gallo et al. 2016]. 

The Similarity Index (SI) quantifies the spatial overlapping of the surface areas 

(SAs) exposed to DivP and ODI above and DivN below their threshold values 

respectively with the surface areas that are subject to TAWSS and WSSax below, 

OSI, RRT, CFI and transWSS above the respective threshold values.  
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The Similarity Index is computed among two haemodynamic parameters i and j, 

as described by the following equation: 

 

SI𝑖𝑗 =
2(𝑆𝐴𝑖∩𝑆𝐴𝑗)

𝑆𝐴𝑖+𝑆𝐴𝑗
   Eq. 47 

 

where Ai and Aj are the relative surface areas exposed to the i-th and the j-th 

descriptors above or below their threshold values, respectively.  

SIij can take any value between zero and one. SIij is equal to zero when the two 

surface areas are not spatially overlapped, whereas it takes a value of one if the 

surface areas Ai and Aj
 are perfectly overlapped and the respective descriptors are 

equivalent. 

The distribution of the similarity indices was characterized in terms of median 

(Me) and median absolute deviation (Mad). 

 

4.7 Sensitivity analysis 
 

A sensitivity analysis was performed on a carotid bifurcation model to verify if 

there was advisable to refine the grid to reduce the uncertainty in the evaluation 

of the wall shear stress divergence, seeing that it is a second order derivative of 

velocity. Utilizing the ANSYS ICEM CFD software, two tetrahedral meshes 

containing about 4,000,000 and 8,000,000 elements respectively were obtained 

(the CCA sections for both the meshes are depicted in Figure 25). The maximum 

dimension of the tetrahedral elements was controlled in order to realize the grids. 

The maximum and minimum dimensions of the elements of the obtained meshes 

are listed in Table 1.  

 

Mesh 4,013,986 elements 8,059,166 elements 

Maximum dimension (m)  2.253 ∗ 10−4 1.782 ∗ 10−4 

Minimum dimension (m)  2.2 ∗ 10−5 1.74 ∗ 10−5 

Table 1. Maximum and minimum dimensions of the elements of the grids realized in sensitivity analysis 
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Figure 25. CCA section in the 4 million elements mesh (left) and in the 8 million elements mesh (right). 

 

The 4 and 8 million elements grids were used to perform two identical steady state 

fluid dynamics simulations in ANSYS FLUENT. In the Computational Fluid Dynamics 

simulation, the blood was considered a Newtonian fluid characterized by a density 

value of 1060 kg/m3 and a constant viscosity of 0.0035 kg/m·s. At the inlet 

(Common Carotid Artery CCA) it was imposed a constant velocity of magnitude 

0.26 m/s, obtained as the ratio between the time-averaged mean flow rate in the 

CCA measured by Marshall et al. in healthy volunteers (6.16 ∗ 10−6 m3/s) 

[Marshall et al. 2004] and the cross-sectional area of the CCA of the considered 

carotid (2.3742 ∗ 10−5 m2). Meanwhile, at the outlets (External Carotid Artery and 

Internal Carotid Artery) it was imposed a reference pressure of 0 Pa. Lastly, it was 

considered a stationary wall.  

Then, the percentage difference between WSS values obtained with the previously 

described meshes (Eq. 48) and the percentage difference between divWSS values 

extracted by using the 4 and 8 million elements grids (Eq. 49) were computed as 

shown below: 

 

|‖
𝑊𝑆𝑆4𝑚 𝑖𝑛𝑡𝑒𝑟𝑝

𝑚𝑎𝑥(𝑊𝑆𝑆4𝑚 𝑖𝑛𝑡𝑒𝑟𝑝)
‖

2

−‖
𝑊𝑆𝑆8𝑚

𝑚𝑎𝑥(𝑊𝑆𝑆8𝑚)
‖

2
|

‖
𝑊𝑆𝑆8𝑚

𝑚𝑎𝑥(𝑊𝑆𝑆8𝑚)
‖

2

= 0.164 = 16.4%           Eq. 48 

|‖
𝑑𝑖𝑣𝑊𝑆𝑆4𝑚 𝑖𝑛𝑡𝑒𝑟𝑝

𝑚𝑎𝑥(𝑑𝑖𝑣𝑊𝑆𝑆4𝑚 𝑖𝑛𝑡𝑒𝑟𝑝)
‖

2

−‖
𝑑𝑖𝑣𝑊𝑆𝑆8𝑚

𝑚𝑎𝑥(𝑑𝑖𝑣𝑊𝑆𝑆8𝑚)
‖

2
|

‖
𝑑𝑖𝑣𝑊𝑆𝑆8𝑚

𝑚𝑎𝑥(𝑑𝑖𝑣𝑊𝑆𝑆8𝑚)
‖

2

= 0.178 = 17.8%           Eq. 49 

 

Where WSS4m and WSS8m are the WSS values obtained with the 4 and 8 million 

elements grid, respectively. Analogously, divWSS4m and divWSS8m are the WSS 
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divergence values for the above-mentioned grids.  The subscript “interp” indicates 

that WSS4m was interpolated at the nodes of the 8 million mesh.  

Therefore, the employ of a 4 million elements mesh entails a percentage error of 

16.4% in the computation of the WSS and 17.8% in the calculation of the divWSS, 

compared to the values obtained with a mesh containing 8 million elements.  

The sensitivity analysis showed that the number of the elements constituting the 

mesh doesn’t strongly influence the output. Moreover, the employ of a more 

refined mesh adds complexity to the computational analysis. So, the 4 million 

elements grid was considered accurate enough for the aims of the present study.  
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Chapter 5. Results 
 

The distributions of the considered haemodynamic wall parameters on the 

bifurcation regions of the forty-six carotid models are reported in Figures from 26 

to 35. As expected, low TAWSS, high OSI and high RRT values are predominantly 

located around the outer walls of the bifurcation, and especially at the carotid bulb 

(as shown in Figures 26, 27 and 28, respectively), where flow separation and blood 

recirculation occur. 
 

 

Figure 26. Exposure to low TAWSS for the 46 carotid bifurcation models. The values reported in the legend 
correspond to 20th and 10th percentile values. 
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Figure 27. Exposure to high OSI for the 46 carotid bifurcation models. The values reported in the legend correspond 
to 90th and 80th percentile values. 

 

Regions on the luminal surface where TAWSS values are low (Figure 26) are 

characterized by slow blood flow, whereas high OSI values (Figure 27) are localized at 

regions where the WSS oscillates. RRT combines this information in a single parameter, 

so the distribution of high RRT (Figure 28) is similar to those that refer to SAs exposed 

to low TAWSS and high OSI values, and it highlights regions of high near-wall 

atherogenic particles residence time. 
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Figure 28. Exposure to high RRT for the 46 carotid bifurcation models. The values reported in the legend 
correspond to 90th and 80th percentile values. 

 

The regions exposed to low TAWSS, high OSI and consequently to high RRT values are 

generally recognized as the most common sites for atherosclerotic plaque 

development in carotid bifurcation. By contrast, high transWSS values are localized at 

the flow divider, as shown in Figure 29, that is normally a plaque-free site. The extent 

of the region subject to high transWSS values is strongly dependent on vessel 

geometry, that influence the amount of flow that is orthogonal to the mean WSS 

direction. 
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Figure 29. Exposure to high TransWSS for the 46 carotid bifurcation models. The values reported in the legend 
correspond to 90th and 80th percentile values. 
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The distributions of SAs exposed to negative WSSax are reported in Figure 30. Negative 

values of this parameter point out regions of flow reversal, that are localized both at 

the carotid bulb and at the ECA entrance. 

 

 

Figure 30. Exposure to negative WSSax for the 46 carotid bifurcation models. 
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In accordance with its definition, CFI assumes high values where both TAWSS and 

transWSS are low, turning out low TAWSS and high transWSS values to be never co-

localized on the surface of the models that were examined in this work. High CFI values 

indicate regions where blood stagnation occur (Figure 31). 

 

 

Figure 31. Exposure to high CFI for the 46 carotid bifurcation models. The values reported in the legend correspond 
to 90th and 80th percentile values. 
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The distribution of high WSS temporal gradient values on the bifurcation regions is 

shown in Figure 32. High WSST values are concentrated, though with variable extent, 

around the carotid apex, conforming to the results obtained in a work on anatomic 

realistic carotid bifurcation geometries by [Lee et al. 2009], and at the inner walls of ICA 

and ECA. 

 

 

Figure 32. Exposure to high WSST values for the 46 carotid bifurcation models. The values reported in the legend 
correspond to 90th and 80th percentile values. 
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Lastly, the spatial distributions of the novel haemodynamic wall parameters based on 

wall shear stress divergence are depicted in Figures 33, 34 and 35. Regions exposed to 

low DivN values are subject to strong negative WSS divergence values on average, that 

correspond to a WSS field directed toward the inside, here referred as sink 

configuration. Such stress results in a compressive force on these portions of the wall. 

 

 

Figure 33. Exposure to low DivN for the 46 carotid bifurcation models. The values reported in the legend 

correspond to the 20th and the 10th percentile values of 𝑑𝑖𝑣𝑊𝑆𝑆̅̅ ̅̅ ̅̅ ̅̅ ̅̅ ̅. 
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On the contrary, high DivP zones on the vessel surface are exposed to wall shear stress 

that points outwards, assuming a source configuration and causing a stretching effect 

on these vessel regions. 

 

 

Figure 34. Exposure to high DivP for the 46 carotid bifurcation models. The values reported in the legend 

correspond to the 90th and the 80th percentile values of 𝑑𝑖𝑣𝑊𝑆𝑆̅̅ ̅̅ ̅̅ ̅̅ ̅̅ ̅. 
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ODI points out large directional changes of WSS between source and sink 

arrangements. Regions on the bifurcation walls characterized by high ODI values 

(Figure 35) are subject to alternative expansions and compressions of the endothelial 

layer during the cardiac cycle.  

 

 

Figure 35. Exposure to high ODI for the 46 carotid bifurcation models. The values reported in the legend 
correspond to 90th and 80th percentile values. 
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On the maps in Figure 36 the surface areas on the vessel wall exposed to a large 

number of sign variations of divWSS during the cardiac cycle are visualized. Specifically, 

the coloured SAs correspond to the regions on the luminal surface of the carotid 

bifurcation models where the Counter takes a value greater than its 80th percentile 

value.  

 

 

Figure 36. Exposure to high Counter values for the 46 carotid bifurcation models. The values reported in the legend 
correspond to 90th and 80th percentile values. 

 

The results of the co-localization analysis are depicted through the similarity index 

distributions in terms of median (Me) and median absolute deviation (Mad). The 

similarity index was computed between each new WSS divergence-based descriptor 

and every pre-existing haemodynamic wall parameter, individually.  
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The distributions of similarity indices for DivN displayed in Figure 37 show that this 

parameter is moderately correlated with low TAWSS (Me=0.433), indicating that a WSS 

field pointing inwards on average during the overall cardiac cycle results in regions of 

blood stagnation. Surface areas exposed to low DivN are also moderately overlapped 

with high OSI regions. This not outstanding result suggests that DivN can capture 

uniaxial flux converging toward a specific region, but it supplies additional information 

as compared to OSI, concerning the directionality of WSS. A moderate co-localization 

can be also observed between DivN and RRT, being the latter defined as a combination 

of TAWSS and OSI able to measure the particles near-wall residence time. These results 

are consistent with the work carried out by Arzani et al. in abdominal aortic aneurysms, 

which demonstrated that negative WSS divergence could typify flow separation. This 

condition implies higher near-wall concentrations of chemical species and higher 

residence time, promoting atherogenic processes [Arzani et al. 2017].    

 

Figure 37. Distribution of SI values for the SA exposed to low DivN with the SA exposed to disturbed flow, as 
defined by the existing HWPs. Each bar of the histograms represents the number of cases with a certain range of 

SI, the blue line represents the cumulative distribution function. Me is the median, Mad is the median absolute 
deviation. 
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DivN weakly co-localizes with high CFI and negative WSSax, indicating that DivN can’t 

capture flow reversal, and it is not correlated with transWSS and WSST. This implies 

that regions where the WSS component perpendicular to the mean flow direction is 

predominant and the WSST is high, as the bifurcation apex, are not characterized by 

converging WSS vectors.  

On the contrary, the SAs exposed to high positive WSS divergence (Figure 38) are 

moderately co-localized with the regions where transWSS values are high (Me=0.403), 

highlighting bifurcation zones characterized by WSS that takes a source configuration. 

A weak co-localization can be observed between the SA exposed to high DivP values 

and the area where WSST is high, even though the data are highly dispersed 

(Mad=0.151). DivP does not show spatial overlapping with the other considered 

existing HWPs (Figure 38, first and second row), suggesting that the regions stressed 

by a source-arranged WSS field are typically concentrated around the flow divider and 

not at the bifurcation bulb, that is recognized as the most common atherosclerotic 

plaque formation site. So, positive WSSdiv values exemplify flow impingement at the 

carotid bifurcation, as stated by [Arzani et al. 2017]. 

The distributions of SI values for ODI (Figure 39) reveals a spatial overlapping between 

the SA exposed to high ODI, where the standard deviation of divWSS is high, and the 

area exposed to high OSI values. This co-localization, characterized by a median value 

of 0.568, is larger than that observed between DivN and OSI (Me=0.402) and it points 

out regions that experience large oscillations of uniaxial WSS between the source and 

sink configurations throughout the entire cardiac cycle. High ODI values are also 

moderately co-localized with high CFI, highlighting regions of flow reversal, with high 

RRT, pointing out high residence time regions, and low TAWSS values, albeit with 

substantial dispersion. The SAs exposed to both high ODI and low TAWSS are 

recirculation zones, where the WSS repeatedly changes its direction and the blood 

stagnates. The fact that ODI better co-localizes with OSI suggests that this new 

parameter could be employed in the detection of regions exposed to an oscillating WSS 

direction. From the absent co-localization of high ODI with high transWSS and high 

WSST, it emerges that the region that is mainly subject to fluctuations between tensile 

and compressive shear stress on the vessel wall is not the bifurcation apex, where high 

transWSS and high WSST values concentrate, but the carotid bulb, that is the most 

athero-prone region. 
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Figure 38. Distribution of SI values for the SA exposed to high DivP with the SA exposed to disturbed flow, as 
defined by the existing HWPs. Each bar of the histograms represents the number of cases with a certain range of 

SI, the blue line represents the cumulative distribution function. Me is the median, Mad is the median absolute 
deviation. 

 

The co-localization analysis was also performed to compare the distributions of the 

novel divergence-based haemodynamic parameters on the carotid bifurcation 

surfaces. The distributions of SI values for the SAs exposed to high ODI values with SAs 

that are subject to low DivN and high DivP values are shown in Figure 40. High ODI is 

moderately co-localized with low DivN (Me=0.441) and it is not co-localized with high 

DivP (Me=0.138). So, regions on the vessel wall that are subject to the lowest negative 

divWSS values on average during the cardiac cycle are also characterized by a greater 

standard deviation, as compared to surface areas where divWSS̅̅ ̅̅ ̅̅ ̅̅ ̅̅  is high. This result 

suggests that flow separation regions, where divWSS̅̅ ̅̅ ̅̅ ̅̅ ̅̅  is negative, can be subject to 

highly variable blood flow and consequently to highly oscillating WSS direction 

between the diverging and converging arrangements. The SI value is mediocre because 
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ODI provides additional information in regard to DivN, concerning the variability of 

WSS direction. On the other hand, regions where the average divWSS is high have a 

lower standard deviation, presumably due to a steadier blood flow. Comparing the 

maps in Figure 35 to those in Figure 34, it can be observed that the surface areas 

exposed to ODI above its 80th percentile value are narrower than the SAs exposed to 

high DivP. So, only small areas on the region of the bifurcation apices are subject to 

large variations in divWSS value, even though divWSS value probably remains positive 

throughout the cardiac cycle. 

The limitation that affects the interpretation of ODI is the fact that this parameter 

points out large oscillations of WSS direction between the source and sink 

configurations only if the distribution of divWSS values is nearly-normal around the 

zero value.  

 

Figure 39. Distribution of SI values for the SA exposed to high ODI with the SA exposed to disturbed flow, as 
defined by the existing HWPs. Each bar of the histograms represents the number of cases with a certain range of 

SI, the blue line represents the cumulative distribution function. Me is the median, Mad is the median absolute 
deviation. 
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Figure 40. Distribution of SI values for the SA exposed to high ODI with the SA exposed to low DivN (left) and with 
the SA exposed to high DivP (right). Each bar of the histograms represents the number of cases with a certain 
range of SI, the blue line represents the cumulative distribution function. Me is the median, Mad is the median 

absolute deviation. 

 

The co-localization analysis was also performed between SA exposed to a high number 

of divWSS consecutive sign changes, represented by high Counter values, and SA 

exposed to high ODI values (Figure 41). 

ODI exhibited a weak co-localization with the Counter (Figure 41). This weak co-

localization of SA exposed to high Counter values and SA exposed to high ODI can be 

explained by the fact that in the definition of the Counter the moduli of divWSS values 

were not taken into account. So, this Counter counts every sign change between two 

consecutive time steps regardless of the modulus change, so it counts small 

fluctuations of divWSS around the zero value as well. These small fluctuations, that 

correspond to low deviations from the uniformity of WSS vector field, are neglected 

when the 80th percentile value of ODI is computed.  

  

 

Figure 41. Distribution of SI values for the SA exposed to high Counter values with the SA exposed to high ODI. Each 
bar of the histogram represents the number of cases with a certain range of SI, the blue line represents the 

cumulative distribution function. Me is the median, Mad is the median absolute deviation. 
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SI values were then computed to quantify the spatial overlapping between the SA 

exposed to high Counter values and the SA exposed to disturbed flow, as defined by 

every established HWP that was considered so far. These distributions (Figure 42) 

follow the trend of ODI co-localization with the pre-existing HWPs, but to a lesser 

extent, reflecting the weak correlation observed between the Counter and ODI (Figure 

41). 

 

 

Figure 42. Distribution of SI values for the SA exposed to high Counter values with the SA exposed to disturbed 
flow, as defined by the existing HWPs. Each bar of the histogram represents the number of cases with a certain 
range of SI, the blue line represents the cumulative distribution function. Me is the median, Mad is the median 

absolute deviation. 

 

To consider the sign changes of divWSS that occur during systole and during diastole 

separately, the cardiac cycle was divided into two parts. Considered the normal 

duration of cardiac phases, [10] for all the carotid bifurcation models the systolic phase 
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was arbitrarily considered to last from the first to the fortieth time step, while the 

following eighty time steps were considered to describe the diastolic phase. Then, two 

distinct counters, named CounterSys and CounterDia, were defined to count the 

number of transitions of divWSS between positive and negative values during the 

systole and the diastole, respectively. For both the counters, the 80th percentile value 

was taken as threshold value to visualize the distribution of high CounterSys and high 

CounterDia values on the surfaces of the models (Figure 43 and Figure 44, respectively) 

and to realize the co-localization analysis with the pre-existing HWPs. 

 

 

Figure 43. Exposure to high CounterSys values for the 46 carotid bifurcation models. The values reported in the 
legend correspond to 90th and 80th percentile values. 
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Figure 44. Exposure to high CounterDia values for the 46 carotid bifurcation models. The values reported in the 
legend correspond to 90th and 80th percentile values. 

 

SAs exposed to high CounterSys values and SAs exposed to high CounterDia values do 

not co-localize, as illustrated by the SI distribution shown in Figure 45. So, the regions 

on the luminal surface that are affected by a shear stress that alternates between 

compressive and tensile vary depending on the cardiac phase. Considered the merged 

surfaces of all the forty-six cut models, CounterSys takes a median value of 3, whereas 

the median value of CounterDia is 2. Being the diastolic phase duration twice as much 

the systole duration, the latter is characterized by a greater number of sign changes of 

divWSS. 



65 
 

 

Figure 45. Distribution of SI values for the SA exposed to high CounterSys values with the SA exposed to high 
CounterDia values. Each bar of the histogram represents the number of cases with a certain range of SI, the blue 

line represents the cumulative distribution function. Me is the median, Mad is the median absolute deviation 

 

The results of co-localization analysis of high CounterSys and high CounterDia with the 

considered established HWPs are shown in Figure 46 and 47, respectively.  

The co-localization trends are comparable to the Counter co-localization with the pre-

existing HWPs, albeit for CounterSys the median values of SI distributions are smaller 

than median values for Counter, whereas the median values for CounterDia are greater 

than those that refer to Counter. The most significant co-localization was observed 

between CounterDia and OSI. So, the number of sign changes of divWSS that occur 

during systole resulted to be more numerous, but less co-localized to the established 

HWPs then the number of sign changes counted during the diastolic phase. 
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Figure 46. Distribution of SI values for the SA exposed to high CounterSys values with the SA exposed to disturbed 
flow, as defined by the existing HWPs. Each bar of the histogram represents the number of cases with a certain 
range of SI, the blue line represents the cumulative distribution function. Me is the median, Mad is the median 

absolute deviation. 
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Figure 47. Distribution of SI values for the SA exposed to high CounterDia values with the SA exposed to disturbed 
flow, as defined by the existing HWPs. Each bar of the histogram represents the number of cases with a certain 
range of SI, the blue line represents the cumulative distribution function. Me is the median, Mad is the median 

absolute deviation. 
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Chapter 6. Conclusions 
 

Several hemodynamic wall parameters have been introduced to describe the role 

of disturbed blood flow in the initiation and progression of atherosclerosis in 

medium and large-sized arteries. The consensus theory recognizes low and 

oscillatory wall shear stress as localizing factors of vascular diseases. Recently, this 

prevailing theory has been questioned and conflicting findings encouraged the 

investigation of different aspects that correlates WSS features with disease. So, 

WSS temporal multidirectionality has recently been proposed as a pro-

atherogenic factor.  

 Aim of this thesis was to introduce new hemodynamic wall parameters (HWPs) 

that can distinguish among tensile, compressive and uniform shear stresses acting 

on the endothelial cells. The direction of WSS could influence the morphology and 

the biology of endothelial cells, increasing the permeability to atherogenic 

particles under the endothelium and altering the balance between pro- and anti-

atherosclerotic signals. However, none of the existing HWPs can capture the 

spatial directionality of WSS. 

The haemodynamic wall parameters proposed in this work are based on the 

divergence of the normalized wall shear stress:  

▪ Negative WSS Divergence (DivN);  

▪ Positive WSS Divergence (DivP);   

▪ Oscillatory WSS Divergence Index (ODI).  

The divergence measures the tendency of the WSS field to converge toward or 

diverge from a point. More in detail, if the WSS vector field takes a sink 

arrangement, then the divergence of WSS is negative, whereas if the WSS takes a 

source configuration, its divergence assumes a positive value. So, DivN was 

defined as the temporal average of the divergence of normalized WSS in 

correspondence of the nodes of the surface mesh where it takes negative values, 

analogously DivP was defined as the temporal average of WSS divergence in the 

nodes where it takes positive values, and ODI was computed as the standard 

deviation of WSS divergence values taken throughout the cardiac cycle at each 

spatial position in the domain. DivN points out regions on the luminal surface that 

experience a sink-arranged WSS on average during the cardiac cycle, with a 

compressing effect on the endothelium. On the other hand, DivP identifies vessel 

wall regions exposed to a source-shaped WSS field, that results in a stretching of 

the vascular surface. ODI can capture the oscillatory behaviour of the shear stress 

applied on the endothelial layer, highlighting vessel wall regions exposed to large 

variations in WSS direction. 

The divergence-based hemodynamic wall parameters were computed on the 

luminal surfaces of forty-six models of right carotid bifurcations acquired from 
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seemingly healthy people. A co-localization analysis of the novel descriptors with 

seven established HWPs was carried out in two steps. Initially, a visual examination 

of the surface areas on the carotid bifurcation regions exposed to wall descriptors 

above or below their respective threshold values was performed. Then, the spatial 

overlapping of the surface areas characterized by low DivN, high DivP and high ODI 

values individually with surface areas exposed to low TAWSS and WSSax, high OSI, 

RRT, CFI, transWSS and WSST was quantified through the evaluation of similarity 

indices. Low DivN showed to be moderately co-localized with low TAWSS, high RRT 

and high OSI, indicating that DivN can highlight bifurcation regions characterized 

by blood stagnation, high near-wall residence time of blood-borne particles, and 

converging uniaxial WSS, respectively. Low DivN regions, that are exposed to a 

compressive shear stress over the cardiac cycle, recognized as flow separation 

regions, were mainly concentrated around the bifurcation expansion. On the other 

hand, high DivP, that indicates flow impingement regions, typically concentrated 

at the bifurcation apex and moderately co-localized with high transWSS, pointing 

out multidirectional source-arranged WSS. ODI spatially overlapped to high OSI to 

a greater extent as compared to DivN, indicating its capability to highlight regions 

exposed to large oscillations of uniaxial WSS between the source and sink 

configurations. Moreover, high ODI moderately co-localized with high CFI, 

indicating flow reversal regions, with high RRT, highlighting high residence times 

near the vessel wall, and with low TAWSS, pointing out recirculation zones. 

A counter was then introduced to verify the correlation of ODI with the number of 

consecutive sign changes of divWSS over the cardiac cycle. This counter did not 

co-localize with ODI, neither with the established HWPs, presumably because it 

does not consider the modulus of the divergence, so it counts even the small 

fluctuations of divWSS value around the zero value, that correspond to low 

deviations from the uniformity of WSS direction. Two distinct counters, 

corresponding to the systole and to the diastole respectively, were then defined 

to count the numbers of sign changes of divWSS during each cardiac phase. The 

number of sign changes of divWSS that occur during systole were more numerous, 

but less co-localized to the established HWPs then the number of sign changes 

counted during the diastolic phase. 

The novel divergence-based descriptors are able to identify converging and 

diverging WSS vector fields. So, the advantage of DivP and DivN, as compared to 

OSI, is the capability to distinguish between tensile and compressive force applied 

on the endothelial layer. In addition, conversely to what transWSS can do, ODI can 

distinguish between reversing uniaxial flow and purely unidirectional flow.  

In this work, in order to take into account the directionality of WSS only, neglecting 

the magnitude of WSS vectors, it was considered the divergence of the normalized 

WSS. Endothelial cells however respond to both magnitude and directional 

changes of WSS. So, to properly describe the impact of flow conditions on the 

biological response of endothelial cells, the divergence-based descriptors that 
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were introduced here can be better used in association with other hemodynamic 

parameters that evaluate WSS magnitude, as TAWSS, RRT or WSSG.  

Moreover, there is a limitation in the use of ODI. This index actually correlates with 

sign changes of WSS divergence, and consequently to large oscillations between 

the source and sink stress configurations if the distribution of divWSS values taken 

during the cardiac cycle is roughly symmetrically-distributed around a mean value 

close to zero.  

To assess the validity of the proposed divergence-based descriptors in 

atherosclerosis prediction, the potential correlation between the directional 

changes of WSS that the divergence-based HWPs can identify and the lesion 

appearance needs to be checked. 
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Appendix 
 

A) Generation of the centerline and cut of bifurcation regions in 

VMTK software 

vmtksurfacereader -ifile C:/wss0040.tec --pipe vmtkcenterlines --pipe 

vmtkbranchextractor --pipe vmtkbranchclipper --pipe vmtkbifurcationsections -id 

3 -i @vmtkbranchclipper.o -distancespheres 3 -sectionpointgroupid 0 -

sectionpointbifurcationgroupid 1 --pipe vmtkbifurcationsections -id 5 -i 

@vmtkbranchclipper.o -distancespheres 5 -sectionpointgroupid 2 -

sectionpointbifurcationgroupid 1 --pipe vmtkbifurcationsections -id 2 -i 

@vmtkbranchclipper.o -distancespheres 2 -sectionpointgroupid 3 -

sectionpointbifurcationgroupid 1 --pipe vmtkpointsplitextractor -i 

@vmtkcenterlines.o -splitpoint @vmtkbifurcationsections-3.sectionpoint -

tolerance 1E-3 -gaplength 0.2 --pipe vmtkbranchclipper -i @vmtksurfacereader.o 

-groupids 0 -insideout 1 --pipe vmtkpointsplitextractor -i @vmtkcenterlines.o -

splitpoint @vmtkbifurcationsections-5.sectionpoint -tolerance 1E-3 -gaplength 

0.2 --pipe vmtkbranchclipper -groupids 0 --pipe vmtkpointsplitextractor -i 

@vmtkcenterlines.o -splitpoint @vmtkbifurcationsections-2.sectionpoint -

tolerance 1E-3 -gaplength 0.2 --pipe vmtkbranchclipper -groupids 0 --pipe 

vmtksurfacewriter -ofile C: /wss_cut.tec 

 

B) Projection of the HWPs onto the bifurcation regions in VMTK 

software 

vmtksurfaceprojection -ifile C:/wss_cut.tec -rfile C:/RRT.tec -ofile C:/RRT_cut.tec 

--pipe vmtksurfaceprojection -ifile C:/wss_cut.tec -rfile C:/tawss.tec -ofile 

C:/tawss_cut.tec --pipe vmtksurfaceprojection -ifile C:/wss_cut.tec -rfile 

C:/osi.tec -ofile C:/osi_cut.tec --pipe vmtksurfaceprojection -ifile C:/wss_cut.tec -

rfile C:/CFI_transWSS_WSSa.tec -ofile C:/CFI_transWSS_WSSa_cut.tec --pipe 

vmtksurfaceprojection -ifile C:/wss_cut.tec -rfile C:/WSST.tec -ofile 

C:/WSST_cut.tec --pipe vmtksurfaceprojection -ifile C:/wss_cut.tec -rfile 

C:/meandivnorm.tec -ofile C:/meandivnorm_cut.tec  

 

C) Sensitivity Analysis 

▪ VMTK 

Exporting a .stl surface: 

Vmtksurfacereader -ifile C:/wss040.tec –pipe vmtksurfacewriter -ofile C:/mesh.stl 
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▪ ANSYS ICEM CFD 

Creating four million elements mesh: 

File -> Import Geometry -> Faceted -> STL -> mesh.stl-> Apri -> Generate -> Done 

Geometry -> Create/modify curve -> Extract Curves from surfaces  

- Surface type: Faceted 

- Angle for surfaces: 90 

- Min number of segments: 1 

- Which curve segments: Both 

Select surfaces -> Select -> Apply -> Ok 

Geometry -> Create/modify Curve -> Segment curve  

- Method: Segment by connectivity 

   Select curve -> Select -> Apply -> Ok  

Create/modify surface -> Simple surface 

- Method: From curves 

Select curve -> Select curves one at a time -> Apply -> Ok 

Parts -> Create part 

            Part: InletCCA -> Select entities -> Select the inlet surface -> Apply -> 

Ok 

    Parts -> Create part 

Part: OUtletECA -> Select entities -> Select the outlet surface 

corresponding to ECA -> Apply -> Ok 

Parts -> Create part 

Part: OUtletICA -> Select entities -> Select the outlet surface 

corresponding              to ICA -> Apply -> Ok 

Parts -> Mesh -> Rename -> Wall -> Done 

Mesh -> Global mesh setup  

Global Mesh Size 

Global Element Scale Factor 

- Scale factor: 1.1e-5  

Global Element Seed Size 

- Max element: 2048 
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Curvature/proximity based refinement  

- Enabled 

- Min size limit: 200 

- Elements in gap: 1 

- Refinement: 18 

Apply -> Ok  

Mesh -> Compute mesh  

 Volume Mesh 

- Mesh Type: Tetra/Mixed 

Tetra/Mixed Mesh 

- Mesh Method: Robust (Octree) 

-> Compute 

Output -> Select solver ->  

- Output solver: ANSYS Fluent  

- Common Structural Solver: ANSYS 

-> Apply 

Output -> Boundary conditions -> Accept  

Output -> Write input  

- Grid dimension: 3D 

- Scaling: No 

- Output file: “mesh4m” -> Done  

To create eight million elements mesh the Global element scale factor has been 

changed to 8.7e-6 and the Output file name to “mesh8m”.  

 

 

▪ ANSYS FLUENT 

 

- Dimension: 3D 

- Options: Double precision 

- Processing Options: Serial -> Ok 

File -> Read -> Mesh -> Select “mesh4m.msh” (or “mesh8m.msh”) file -> Ok 

Display -> Mesh  

Options: Edges 
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Edge Type: All 

Surfaces: 

- inletCCA 

- outletECA 

- outletICA 

- wall 

-> Display -> Close 

Solution Setup 

• General  

Mesh -> Scale ->  

- View length unit in: m 

- Scaling  

Specify scaling factor 

Scaling Factors: 

X =0.01  

Y =0.01  

Z =0.01 

-> Scale -> Close 

Mesh -> Check 

Solver  

- Type: Pressure-based 

- Velocity Formulation: Absolute  

- Time: Steady 

 

• Models -> Viscous-Laminar 

 

• Materials -> Fluid -> Create/edit 

- Name: Blood 

- Density: constant  

1060 kg/m3 

- Viscosity: constant 

0.0035 kg/m*s 

Change/create -> Close  

• Cell zone Conditions -> Type: Fluid -> Edit -> Zone Name: Blood -> Ok 

 

• Boundary condition 

 

- InletCCA  

Type: velocity-inlet 
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-> Edit  

Momentum 

Velocity Specification Method: Magnitude, Normal to Boundary 

Reference Frame: Absolute 

Velocity magnitude: 0.26 m/s 

-> Ok  

- Int_Fluid  

Type: Interior 

 

- OutletECA  

Type: pressure Outlet 

Momentum 

Gauge Pressure: 0 Pa 

Backflow Direction Specification Method: Normal to Boundary 

-> Ok 

- OutletICA  

Type: pressure Outlet 

Momentum 

Gauge Pressure: 0 Pa 

Backflow Direction Specification Method: Normal to Boundary 

-> Ok 

- Wall 

Type: Wall 

 

Solution 

• Solution Methods  

Pressure-Velocity Coupling 

Scheme: SIMPLE 

Spatial Discretization 

 Gradient: Least Squares Cell Based 

Pressure: Second Order 

Momentum: Second Order Upwind 

• Monitors  

Residuals, Statistic and Force Monitors 

 Residuals-Print, Plot -> Edit 
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Residual 

- continuity: 0.0001 
- x-velocity: 0.0001 
- y-velocity: 0.0001 
- z-velocity: 0.0001 

Convergence Criterion: absolute 

-> Ok  

• Solution Initialization  

Initialization Methods: Standard Initialization 

Reference Frame: Relative to Cell Zone 

Initial Values: 

Gauge Pressure: 0 Pa 

X Velocity: 0 m/s 

Y Velocity: 0 m/s 

Z Velocity: 0 m/s 

 -> Initialize 

• Run Calculation -> Check case 

Number of iterations: 3000 

-> Calculate 
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